
Version Information
Product

SmartSketch LE for the Windows 95, Windows 98, and Windows NT 4.0 and higher operating systems

Product Number

SGBY247AA-0300A

Version

03.00.85.04

Date

31-July-1999

Description

SmartSketch LE is a technical drawing and diagramming product. It is the baseline for a line of add-ins and 
solutions for the technical drawing, CAD, and professional/business diagramming marketplace. It is a is a limited 
edition of the full product that may be used throughout the office and is specifically designed to work with the 
Microsoft Office products.



Late Breaking Information
Mathcad® Integration

Mathcad® 8 Professional provides the calculating and analytical power necessary to solve a wide range of math,
science, and engineering problems. In cooperation with MathSoft, SmartSketch now delivers a Mathcad 
component that allows integration between the two products. You can access this component from the Mathcad 
Insert Component menu. It allows you to insert SmartSketch designs into Mathcad Professional documents and 
link variables without programming.

You can find details of this integration in the SmartSketch\Samples\Mathcad\Readme.rtf file. This directory also 
contains several sample files.

Linked AutoCAD and MicroStation Files

SmartSketch LE does not support IGR files that contain links to AutoCAD or MicroStation files. Opening and 
working with these files produces error messages. You can upgrade to the full product, SmartSketch, for support 
of AutoCAD and MicroStation files.

http://www.SmartSketch.com

Display Priority

When symbols are glued to symbols that are glued to other symbols, the display priority is sometimes incorrect 
and symbols nested inside other symbols can be obscured. This display issue occurs only if there are more than 
three symbols glued on top of each other. You can rectify the display by using the F5 key to refresh the window.

Additional late breaking information is contained in the SmartSketch Knowledge Base. To get to the knowledge 
base, click the following link:

http://www.intergraph.com/SmartSketch/LE/support



Installation
System Requirements

Microsoft Windows 95 B, Windows 98, or Windows NT 4.0 with SP3 or higher
Microsoft Internet Explorer 4.0 or higher required to view Programming guide.
Pentium 133 microprocessor or higher
64 MB RAM recommended
60 MB disk space for minimum installation (120 –170 MB disk space recommended)
CD-ROM drive
800 x 600 resolution or higher
Microsoft or Microsoft-compatible mouse (IntelliMouse® recommended)

Installing SmartSketch

SmartSketch LE 3.0 automatically uninstalls any previous version of Imagineer Technical or Imagination 
Engineer upon installation. 
1 Determine whether to install from the CD or the network. Install from the network if you want to load symbols and

tutorials in a networked location for distributed access.
From a CD-ROM drive–Insert the CD into its drive. If the installation does not start on your Windows® system,
run Setup from your CD-ROM drive. Click setup.exe.
From a Network–From Start on the taskbar, click Run, and enter the path on your network to the SmartSketch
setup.exe file.    Please record your installation path for quick reference: 
Note    We recommend a UNC network connection, such as \\myserver\share\setup, so you can easily access
the symbols and tutorials after installation.

2 Follow the installation instructions on your screen. Choose an installation option from below:
TypicalCompact
Custom

3 Set up your path to access the tutorials and symbols, unless you installed them using the Custom option. 
For CD installations–Leave the CD in the CD-ROM drive to access tutorials and symbols.
For network installations–Verify the network drive or UNC network connection where the product was 
installed. 

            System Management Services (SMS) Support  

Registering Your Software Gives You
Free Email support
Product updates and bulletins about related products
Extra symbol set

Ways to register
Check the I would like to register SmartSketch now. box on the Installation Completion dialog box.
Click Register SmartSketch LE on the Help menu.



System Management Services Support (SMS)
SmartSketch setup supports installation of SmartSketch over a network. However the SMS administrator should 
ensure the following before running a silent setup over a network.
1 SmartSketch or previous versions should be uninstalled prior to network installation.
2 The client machines should not have a directory by the same name to which SmartSketch is to be installed.
3 The client machine should have the following free disk space available:

TEMP Dir Drive: 3000 kb 
System Drive: 4800 kb
Additional hard drive space for Typical installation: 123,000 kb
Additional hard drive space for Compact installation: 59, 000 kb
Additional hard drive space for Custom installation: 165, 000 kb

The figures shown above are the maximum disk space that the product can use because of the file system 
overhead.

Three response (.iss) files are included with the product. The administrator can use them or create his own .iss 
file by running Setup   –  r   from a command line.

If you choose to record your own .iss file:
1 Choose ‘No’ to indicate not to reboot the machine after installation. The setup will update the system when it is 

next rebooted. If you must choose ‘Yes’ to reboot immediately after setup, edit the .iss file you created as 
following:
In the Dialog box data keynames section change the BootOption=0 for [SdFinishReboot-0] to BootOption=3.

2 In the [File Transfer] section change OverwriteReadOnly=NoToAll to OverwriteReadOnly=YesToAll.
A PDF file is also provided for use with the SMS server. You may create you own PDF file or import the one 
that is provided.
Setup.log is the default name for the silent setup log file.    You can specify a different name and location for 
Setup.log using the -f1 and -f2 switches with Setup.exe. The [ResponseResult] section of Setup.log file 
contains the result code indicating whether or not the silent setup succeeded.

Setup.log
Setup.log is the default name for the silent setup log file, and its default location is Dis in the same folder as 
Setup.ins. You can specify a different name and location for Setup.log using the -f1 and -f2 switches with 
Setup.exe .

The Setup.log file contains three sections. The first section, [InstallShield Silent], identifies the version of 
InstallShield Silent used in the silent setup. It also identifies the file as a log file.

The second section, [Application], identifies the installed application's name and version, and the company 
name.

The third section, [ResponseResult], contains the result code indicating whether or not the silent setup 
succeeded. An integer value is assigned to the ResultCode keyname in the [ResponseResult] section. Setup 
places one of the following return values after the ResultCode keyname:

0 Success.

-1 General error.

-2 Invalid mode.

-3 Required data not found in the Setup.iss file.

-4 Not enough memory available.

-5 File does not exist.

-6 Cannot write to the response file.

-7 Unable to write to the log file.

-8 Invalid path to the InstallShield Silent response file.

-9 Not a valid list type (string or number).



-10 Data type is invalid.

-11 Unknown error during setup.

-12 Dialog boxes are out of order.

-51 Cannot create the specified folder.

-52 Cannot access the specified file or folder.

-53 Invalid option selected.

The Setup.log file for a successful silent setup of SmartSketch is shown below.

[InstallShield Silent]
Version=v5.00.000
File=Log File
[Application]
Name=SmartSketch LE
Version=03.00
Company=Intergraph Corporation
Lang=0009
[ResponseResult]
ResultCode=0
Setup.exe
Setup.exe is the main setup executable; it performs setup initialization and launches the appropriate Setup 
engine file (_instxxx.ex_, where xxx indicates the target platform) to execute the setup script (Setup.ins) on the 
target system. 

You can pass command line switches directly to Setup.exe.

Syntax

Setup [switches]

Switches

These switches are optional. They are not case sensitive; upper- or lowercase letters can be used.

/f<path\CompiledScript> or -f<path\CompiledScript>

Specifies an alternate compiled script. Unless the compiled script (.ins file) also resides in the same directory as 
that of Setup.exe, the full path to the compiled script must be specified. _setup.dll must also reside in the same 
directory as your .ins file. For example, setup -ftest.ins will launch setup using Test.ins instead of Setup.ins.

/f1<path\ResponseFile> or -f1<path\ResponseFile>

Specifies an alternate location and name of the response file (.iss file). If this option is used when running Silent 
setup, the response file is read from the folder/file specified by<path\ResponseFile>. If this option is used along 
with the -r option, the response file is written to the folder/file specified by<path\ResponseFile>. If an alternate 
compiled script is specified using the -f switch, the -f1 switch entry must follow the -f switch entry.

/f2<path\LogFile> or -f2<path\LogFile>

Specifies an alternate location and name of the log file created by Silent setup. By default, Setup.log log file is 
created and stored in the same directory as that of Setup.ins. If an alternate compiled script is specified using the
-f switch, the -f2 switch entry must follow the -f switch entry.

/m<filename> or -m<filename>

Causes Setup.exe to generate a Management Information Format (.mif) file automatically at the end of the setup.
Do not include a path—the .mif file is always placed in the Windows folder. <filename> is optional. If you do not 
specify a filename, the resulting file will be called Status.mif.

/m1<serial number> or -m1<serial number>

Tells setup to place the indicated serial number in the created .mif file.

/m2<locale string> or -m2<locale string>

Tells setup to place the indicated locale in the .mif file. English (ENU) is the default; refer to Microsoft 
documentation for a complete listing of locale strings.



/r or -r

Causes Setup.exe automatically to generate a silent setup file (.iss file), which is a record of the setup input, in 
the Windows folder.

/s or -s

Runs Silent setup to execute a silent setup .

/SMS or -SMS

Prevents a network connection and Setup.exe from closing before the setup is complete. This switch works with 
setups originating from a Windows NT server over a network. Please note that SMS must be uppercase; this is a
case-sensitive switch.

/z or -z

Prevents Setup.exe from checking the available memory during initialization. This switch is necessary when 
running a setup on a machine with more than 256 MB of memory; if it is not used, Setup.exe reports insufficient 
memory and exits.

Comments

Separate multiple command line switches with a space. But do not put a space inside a command line switch (for
example, /r /fInstall.ins is valid, but not /r/f Install.ins).

When using long path and filename expressions with switches, enclose the expressions in double quotation 
marks. The enclosing double quotes tell the operating system that spaces within the quotation marks are not to 
be treated as command line delimiters. 

Response File
A normal (non-silent) setup receives the necessary input from the user in the form of responses to dialog boxes. 
However, a silent setup does not prompt the user for input. A silent setup must get its user input from a different 
source. That source is the file (.iss file).

A response file contains information similar to that which an end user would enter as responses to dialog boxes 
when running a normal setup. Silent setup reads the necessary input from the response file at run time.

The format of response files resembles that of an .ini file, but response files have .iss extensions. A response file 
is a plain text file consisting of sections containing data entries. 

There are two ways in which you can create an response file: You can run the setup and have the setup record 
and create the response file for you, or you can write the response file from scratch.

Recording a response file

You have the option of letting Setup create the response file for you. Simply run your setup with the Setup.exe -r 
command line parameter. Setup will record all your setup choices in Setup.iss and place the file in the Windows 
folder.

All the Setup dialog box functions write values into the Setup.iss file when Setup runs in record mode (Setup -r). 

Manually creating a response file 

You can also create the response file completely by hand. As mentioned, the Setup.iss file is similar to an .ini file.
The sections of an Setup response file must be in the following order:
1 Response File Header Section
2 Response File Application Header Section
3 Response File Dialog Box Sequence Section
4 Response File Dialog Box Data Section

Section names are contained in square brackets, as in [InstallShield Silent].

Data entries follow their section names, and consist of <name=value> pairs, as in Dlg0=Welcome-0.

Follow these steps to create the response file:
1 Create a text file named Setup.iss using any text editor.
2 Enter the silent header into Setup.iss.
3 Enter the application header into Setup.iss.



4 Enter the dialog box sequence into Setup.iss.
5 Enter the dialog box data into Setup.iss.
6 Save and close Setup.iss.

Three sample response files (Typical.iss, Compact.iss and Custom.iss) are delivered with the product that may 
be used for Typical, Compact or Custom setup. or help familiarize you with the format.

Response file header

All response files begin with a response file silent header. The response file silent header allows InstallShield to 
identify the file as a legitimate InstallShield response file. It also helps to verify that the response file corresponds
to an setup created with the proper version of InstallShield.

The format of the silent header is shown below. Enter the following lines at the beginning of your Setup.iss file:

[InstallShield Silent]
Version=v5.00.000
File=Response File
Use v5.00.000 in all response files.

Response file application header

The response file application header is the second block of information in the response file, immediately following
the response file silent header. The response file application header allows setup developers to identify response
files visually. It is not used by the setup script or by Setup.exe. Setup developers can use the application header 
to identify exactly which setup the response file is for, since it is often difficult to determine this by looking at the 
dialog box data.

The format of the application header is shown below. Enter the following lines into your Setup.iss file below the 
silent header:

 [Application]
Name=SmartSketch LE
Version=03.00
Company=Intergraph Corporation
Lang=0009
Response file dialog box sequence

The third block of information in the response file, after the silent header and the application header, is the 
response file dialog box sequence. The dialog box sequence section lists all dialog boxes you would need to use
in a normal setup (including custom dialog boxes), in the order in which they would appear. The dialog boxes are
listed under the section heading [DlgOrder].

The dialog box numbering sequence begins at 0. There is no limit to the number of dialog boxes you can list.

The order and the number of dialog boxes is significant. When InstallShield Silent runs, if either the number or 
the order of the dialog boxes does not match the order or the number of the dialog boxes in the non-silent setup, 
the silent setup fails and the log file records the failure. Make one entry for each occurrence of a dialog box. A 
given dialog box may be listed more than once if it appears more than once in the setup.

The format for a dialog box sequence entry is Dlg<#>=<DialogIdentifier>. Dlg<#> consists of the letters Dlg and 
a sequence number. The first dialog box in the setup is Dlg0. Each dialog box after that increments the value of 
<#> by one.

<DialogIdentifier> is in the form functionname-<#>, where functionname is the name of the function that created 
the dialog box, and <#> represents the sequential order of that particular dialog box in the setup.

For custom dialog boxes, you can use any unique alphanumeric name for the functionname portion of 
<DialogIdentifier>. For example, you could refer to a custom dialog box as MyDialog. If the tenth dialog box in 
the setup were the second occurrence of the custom dialog box MyDialog, there would be an entry in the dialog 
box sequence section like this:

Dlg9=MyDialog-1
The <DialogIdentifier> expression will be used to identify the dialog box data section for the dialog box. 

Always end the dialog box sequence section with a statement of the form Count=<number of dialog boxes> that 
specifies the exact number of dialog boxes listed in the dialog box sequence section. Count every entry. Since 
dialog box numbering begins with 0, the value of Count will always be 1 greater than the highest <#> value for a 



dialog box sequence.

The example below lists two dialog boxes, the Welcome dialog box and the AskOptions dialog box. Enter your 
dialog box sequence list into Setup.iss as shown in the example below.

 [DlgOrder]
Dlg0=Welcome-0
Dlg1=AskOptions-0
Count=2
Response file dialog box data section 

The last block of information in a response file is the response file dialog box data. The response file dialog box 
data is a collection of sections containing the values returned by each dialog box identified in the dialog box 
sequence section. Each dialog box has its own section. The values listed are the same values that the dialog box
returns in a normal, user input-driven setup. 

Dialog box data section format

[<DialogIdentifier>]
Result=value
Keyname1=value
Keyname2=value
The format for a dialog box data section is shown above. The [<DialogIdentifier>] section header identifies the 
specific dialog box and is followed by the dialog box data entry list. <DialogIdentifier> is the same expression 
used to list the dialog box in the dialog box sequence section.

Data entry items are in the format keyname=value. The keyname is a name for a value returned by a dialog box 
and recorded in the response file. All dialog boxesreturn a value for the keyname Result, reflecting the button 
that was clicked to end or exit the dialog box. Many dialog boxes will also set or return a value in a variable.

For example, in a non-silent setup the AskDestPath dialog box returns the destination location in the svDir 
parameter. The line in the our script might look like the following:

nResult = AskDestPath( szTitle, szMsg, svDir, 0 );
The corresponding dialog box data entry in the Setup.iss file for a silent setup might look like the following:

[AskDestPath-0]
Result=1
szPath=C:\Program Files\SmartSketch
In the above example, Result=1 is equivalent to clicking the Next button in the dialog box, and szPath=C:\
Program Files\SmartSketch is the value returned in the svDir parameter of AskDestPath.

The name of the variable used in the script is meaningless relative to the Setup.iss file. However, in the Setup.iss
dialog box data sections, each built-in and Sd dialog box has its own set of keynames which map to its 
parameters. The keynames are important and must be exact as defined for each dialog box. Refer to Dialog box 
data keynames list, below.

Result standard values

All dialog boxes return a keyname value called Result, indicating which push button was clicked to end the dialog
box. Unless otherwise indicated, the Result standard values are:

12    for the Back button

1 for the Next or OK button

Recording component and subcomponent selections

Some dialog box functions allow the user to select components and subcomponents. There are three kinds of 
dialog box data keyname entries used to record component and subcomponent selections in response files:    
type, count, and <#> (described below).

Every set of component selections and every set of subcomponent selections has one type keyname entry, one 
count keyname entry, and as many <#> keyname entries as are required to document each individual 
component or subcomponent selection.

When creating keynames to record component selections, precede the type, count, and <#> keyname entries 
with the word "Component", thus:



Component-type
Component-count
Component-0 
When creating keynames to record subcomponent selections, precede the type, count, and <#> keyname entries
with the name of the component to which the subcomponents belong, thus:

Program Files-type
Program Files-count
Program Files-0
Program Files-1
To create complete value entries, use the equal sign to attach the values to the keynames. (The types of values 
assigned to each kind of keyname are described below.)    The following example shows complete value entries 
for two components, Program Files and Binary Files, and two subcomponents of Program Files, Executables and
Support Elements:

Component-type=string
Component-count=2
Component-0=Program Files
Component-1=Binary Files 
Program Files-type=string
Program Files-count=2
Program Files-0=Executables
Program Files-1=Support Elements
Type keyname entry

The type keyname indicates the data type of the components or subcomponents list. Since InstallShield dialog 
boxes currently use only string lists for components and subcomponents lists, type is always equal to "string", as 
in Component-type=string. Future versions may use number lists, in which case type could equal "number".

Count keyname entry

Count is equal to the number of selections for a given component or subcomponent entry. For example, if two 
components were selected for installation in the ComponentDialog dialog box, the count dialog box data entry 
would be Component-count=2. If two subcomponents of the Program Files component were selected, there 
would be a Program Files-count=2 entry.

<#> keyname entry

The number portion of the <#> keyname entry is simply a sequential (one-up) number, beginning with 0, that 
numbers each recorded component or subcomponent selection. Since numbering begins with 0, the greatest 
number value will always be one less than the value of count.

The value assigned to a <#> keyname entry is the selected component's or subcomponent's visible name (the 
string passed as the second parameter to ComponentAddItem when the components or subcomponents list was 
built).

For example, assume the ComponentDialog dialog box offers the user a component selection of Program Files, 
Help Files, Sample Files, and Utilities. If the user selects Program Files and Help Files, then the dialog box data 
section for that instance of the ComponentDialog dialog box will have two list item entries and will look something
like this:

[ComponentDialog-0]
szDir=C:\MYAPP\FILES
Component-type=string
Component-count=2
Component-0=Program Files
Component-1=Help Files
Result=1
The following example shows how subcomponent list selections are recorded. The example is for an instance of 
the SdComponentMult dialog box. The example shows that two components—Program Files and Help Files—
were selected. It also shows that four subcomponents were chosen—Main Files, Aux. Files, Main Help, and 
Tutorial Files. Main Files and Aux. Files are subcomponents of Program Files, and Main Help and Tutorial Files 
subcomponents of Help Files.



[SdComponentMult-0]
Component-type=string
Component-count=2
Component-0=Program Files
Component-1=Help Files
Program Files-type=string
Program Files-count=2
Program Files-0=Main Files
Program Files-1=Aux. Files
Help Files-type=string
Help Files-count=2
Help Files-0=Main Help
Help Files-1=Tutorial Files
Result=1
Dialog box data keynames list

The dialog box data keynames for the dialog boxes are listed in the table below. The first column contains the 
dialog box names. The second column lists the keynames applicable to each dialog box. The third column 
contains descriptions of the values associated with the keynames.
Dialog box Keyname Description

AskYesNo-<#> Result 1 = User selected "Yes"
0 = User selected "No"

SdAskDestPath-<#> Result Standard values
szDir The path entered in the Destination Directory 

edit Field

SdComponentMult-<#> Result Standard values
Component-type, String (the only value currently allowed)
<subcomponent>-type
Component-count, The total number of component or 

subcomponent selections
<subcomponent>-count 
Component-number, The selected item's number in the list 

(numbering begins with 0)
<subcomponent>-<#>

SdConfirmNewDir-<#> Result 1 = User selected "Yes"
0 = User selected "No"

SdConfirmRegistration-<#> Result 1 = User selected "Yes"
0 = User selected "No"

SdFinishReboot-<#> Result 1 = Finish BootOption
0 = Do not restart Windows or the machine
2 = Restart Windows
3 = Reboot the machine

SdLicense-<#>
Result 12 = Back

1 = User selected "Yes"

SdRegisterUser-<#> Result Standard values
szName The text entered in the Name field
szCompany The text entered in the Company field



szSerial The text entered in the Serial (number) field

SdSelectFolder-<#> Result Standard values
szFolder The folder name entered in the Program 

Folder field

SdSetupType-<#> Result 12 = Back 
Or, when the Next button is clicked:
301 = Typical radio button is currently 
selected
302 = Compact radio button is currently 
selected
303 = Custom radio button is currently 
selected

szDir The path entered in the Destination Directory 
edit field

SdStartCopy-<#> Result Standard values

SdWelcome-<#> Result Standard values



Starting the Software
To start SmartSketch, click Start on the Windows Taskbar, then click Programs and, in the Intergraph 
SmartSketch menu item, click SmartSketch.



Tools for Learning
On-line Help

The SmartSketch on-line Help contains reference information about commands, dialog boxes, and procedures. 

To get on-line Help, start SmartSketch. Once you are in SmartSketch , you can click SmartSketch Help on the 
Help menu.

Getting Started

Getting Started contains lessons that teach you how to use SmartSketch . To launch this learning tool, click Start 
on the Windows Taskbar. Then, click Programs and, in the Intergraph SmartSketch menu item, click Getting 
Started. 



How to Contact Intergraph
Customers worldwide can use the following on-line support services (in English):

World Wide Web at http://www.intergraph.com/SmartSketch/LE/default.asp 
You can use any of the popular browsers to connect to the SmartSketch Web site. 
Note You can also obtain technical support at the following web address, after you register the product: 
http://www.intergraph.com/SmartSketch/LE/support

E-mail

Outside North America

For general information or details about service options outside of North America, contact your local Intergraph 
office.



E-mail
For general information about SmartSketch , send e-mail to the following address: SmartSketch@ingr.com

Any type of Internet e-mail software may be used to submit a service request. You can also connect to the 
SmartSketch    support page and submit a service request.

To Create Your Own Support Request 
1 Start your e-mail software and create a message.
2 In the e-mail message, address the message as follows: service@intergraph.com.

Note If your e-mail message does not deliver when you send it, you might need to add brackets, SMTP 
(Simple Mail Transfer Protocol), or other qualifiers to the address, depending on the software you are using. 
For example, you may need to add brackets as in the following example:

[SMTP: service@intergraph.com]
3 In this Help window, place the mouse cursor by the text and drag to select all the following lines:

[SERIAL #] 
[NAME] 
[PHONE] 
[MPATH] 
[PRODUCT] SMARTSKETCH
[VERSION] 
[DESCRIPTION BELOW]

4 On the Edit menu, click Copy. 
5 In the e-mail message, paste the information that you copied. The E-mail must contain all the lines.
6 After each item in brackets, type the appropriate information. [PRODUCT] is already filled out.

When entering information after the item [DESCRIPTION BELOW], please limit each line of the problem 
description to a maximum of 60 characters.

7 Send the e-mail message. You will receive an e-mail message later to verify the worksheet number or indicate 
why your service message did not process correctly.



Security Information
SmartSketch for Windows NT 4.0 or higher, Windows 95, and Windows 98 will run under user, administrator, or 
guest privileges.
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Argentina
Runco Hermanos, S.C.

BDO. de Irigoyen 308 - Primer Piso

1379 Buenos Aires, Argentina

Tel:        (54-1) 334-1420

                    (54-1) 334-2877

                    (54-1) 334-1420

FAX : (54-1) 334-8804

Email: runco@satlink.com



Australia
INTERGRAPH CORP. PTY. LTD. (SUBSIDIARY) PERTH OFFICE

Technology Park Unit 2 

4 Brodie Hall Drive 

Bentley Western Aust, Australia 6102 

Phone: +61 8 9-47-232-66 

FAX: +61 8 9-47-232-67

INTERGRAPH CORP. PTY. LTD. (SUBSIDIARY) BRISBANE OFFICE 

7th Floor, 126 Margaret Street 

Brisbane, Queensland Australia 4000 

Phone: +61 7-322-989-05 

FAX: +61 7-322-107-87 

INTERGRAPH CORP. PTY. LTD. (SUBSIDIARY) CANBERRA OFFICE 

Level 1 19 Barry Drive 

Turner Act 2601 

Canberra, Australia 2601 

Phone: +61 6-25-730-66 

FAX: +61 6-25-731-03 

INTERGRAPH CORP. PTY. LTD. (SUBSIDIARY) MELBOURNE OFFICE 

35 Cotham Road 

Kew East, Victoria Australia 3101 

Phone: +61 3-929-113-33 

FAX: +61 3-985-337-00 

INTERGRAPH CORP. PTY. LTD. (SUBSIDIARY) SYDNEY OFFICE 

Riverside Corporate Park

Level 3, 2 Julius Avenue

North Ryde, New South Wales Australia 2113 

Operator: +61 2-988-899-00 

FAX: +61 2-988-890-09 

E-mail: naboyle@intergraph.com

INTERGRAPH ASIA-PACIFIC, INC. (ASIA PACIFIC HEADQUARTERS) 

Level4 

32 Walker Street 

North Sydney, Australia 2060 

Phone: +61 2-992-928-88 



FAX: +61 2-992-927-88



Austria
INTERGRAPH GMBH (AUSTRIA) 

Modecenterstrasse 14 

Block A, 4 Stock 

Vienna, Austria A-1030 

Operator: +43 1-79-735-0 

FAX: +43 1-79-735-35

Mailpath: info-austria@intergraph.com



Bahamas
ISLAND NETWORKS INCORPORATED

Palmdale Ave. & Montgomery St.

Nassau Bahamas

P.O. BOX N-4524

Tel:    (242) 325-4727 / (242) 326-5389

FAX    (242) 328-4973

Email:    mrtim@batelnet.bs



Bahrain
INTERGRAPH MIDDLE EAST GULF EC (LOCAL SUBSIDIARY) 

Building 169, Road 1405, Block 314 

P.O. Box 1715 

Manama, Bahrain 

Operator: +973 271-90-0 

FAX: +973 270-24-1 

Mailpath: info-middleeast@intergraph.com 



Barbados
CCS Limited 

Geddes Grant Building 

PO Box 872E

Whitepark Road

St. Michael, Barbados

Contact: Ervel Burnham

Email: ccsgov@caribsrf.com

Operator: 246-431-5600

FAX: 246-427-6089



Belgium
INTERGRAPH BENELUX BV (SUBSIDIARY) 

Tennessee House - Riverside Business Park 

Internationalelaan 55 

Brussels, Belgium B-1070 

Operator: +32 2-52-621-11 

FAX: +32 2-52-621-50 

Mailpath: info-belgium@intergraph.com



Bolivia
Casa Bernardo S.A.

Avenida Camacho 1296 (Esq. Colon)

P.O. Box 685

La Paz—Bolivia

Tel. (591-2) 32-9623

(591-2) 32-7090

(591-2) 39-1003

Fax. (591-2) 32-8183

(591-2) 39-1003

e-mail cbsa@datacom-bo.net



Brazil
Sisgraph    Ltda.

Rua Estados Unidos, 116

Jardim Paulista

São Paulo - SP    01427—Brazil

Tel. (5511) 889-2000

Fax. (5511) 887-7763

Email:    ssteinbe@brazil.brazil.ingr.com



Canada
INTERGRAPH CANADA LTD. (SUBSIDIARY) 

2912 Memorial Drive S.E. 

Calgary, Alberta Canada T2A 7R9 

Operator: (403) 569-5500 

FAX: (403) 569-5801 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. (SUBSIDIARY) 

Suite 700, Sun Life Place 

10123 99th Street 

Edmonton, Alberta Canada T5J 3H1 

Operator: (403) 424-7431 

FAX: (403) 424-9066 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. (SUBSIDIARY) 

#610, 4370 Dominion Street 

Burnaby, British Columbia Canada V5G 4L7 

Operator: (604) 434-2677

FAX: (604) 433-1418 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. (FIELD SERVICE OFFICE) 

50 Carlos Lane 

Winnipeg, Manitoba Canada, Manitoba R3R 2L8 

Operator: (204) 334-0014 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. (SUBSIDIARY) - (FIELD SERVICE OFFICE) 

350 Wetmore Road 

Fredericton, New Brunswick Canada, New Brunswick 

Operator: (506) 459-8486 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. (SUBSIDIARY) 

Suite 407, 1959 Upper Water Street 

Halifax, Nova Scotia Canada B3J 3N2 

Operator: +902 425-1142 

FAX: (902) 422-2388 



Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. (SUBSIDIARY) (TORONTO) 

Suite 250 

7070 Mississauga Road 

Mississauga, Ontario Canada L5N 7G2 

Operator: (905) 812-9755 

FAX: (905) 812-9754 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. 

#100, 200 Montcalm St. 

Hull, Quebec Canada J8Y 3B5 

Operator: (819) 772-2040 

FAX: (819) 772-4449 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. 

1220 Boul Lebourneuf 

Bureau 210 

Quebec City, Quebec Canada G2K 2G4 

Operator: (418) 626-2405    

FAX: (418) 626-4592 

Mailpath: icanorder@icanmail.canada.ingr.com 

INTERGRAPH CANADA LTD. (MONTREAL) 

#300, 14 Place Du Commerce 

Ile-Des-Soeurs 

Verdun, Quebec Canada H3E 1T5 

Operator: (514) 766-1292 

FAX: (514) 766-3507 

Mailpath: icanorder@icanmail.canada.ingr.com 



Chile
INGENIERIA Y SISTEMAS GRAFICOS S.A. (ISG)

Alameda 552 4o. Piso

Santiago - Chile

Tel:    (56 2) 639-4480

Email:    rcamhi@isg.cl

VIDEOGRAFICA LTDA.

Mar del Plata 1952

Providencia, Santiago, Chile

Tel:    (56-2-2232-463

FAX    56-2--341-4690

Email:    roque@vg.cl

abuzeta@vg.cl



China, People’s Republic of
INTERGRAPH CHINA INC.

Beijing Representative Office

Room 1201, The Gateway 

10 Yabao Road, Chaoyang District 

Beijing, China, People's Republic Of 100020 

Operator: +86 10-6592 5270 ~75

FAX: +86 10-6592 5268 

E-mail: jnwang@ingr.com

INTERGRAPH CHINA INC.

Shanghai Liaison Office 

Rm 5f-A Eastern Business Building 

No. 586 Fan Yu Road 

Shanghai, China, People's Republic Of 200052

Operator: +86 21-6283 4365

FAX: +86 21-6283 4366

E-mail: wtdrisco@ingr.com



Colombia
VOXEL, S.A.

Avenida 28 39B-09 Piso 3

Santafé de Bogotá, D.C. -Colombia

Tel. (571) 368-9223

Fax. (571) 368-9224    

Email: clmvox@colomsat.net.co

EBC INGENIERIA COMPANIA LTDA.

Carrera 18 # 86A-54

Santafé de Bogotá, D.E. 8117-Colombia

Tel. (571) 218-5337

(571) 622-8575

Fax. (571) 622-8582    

Email:    Arlebc@colomsat.net.co



Costa Rica
CONTINEX, S.A.

Avenida 10 Calles 34 y 36

Apartado 746-1000

San José-Costa Rica

Tel. (506) 233-0933

Fax. (506) 221-6905

E-Mail: Hcaamano@superior.co.cr



Czech Republic
INTERGRAPH CR 

Podbabska 20 

Praha 6 

Prague, Czech Republic 160 46 

Operator: +420 2-243-117-41 

FAX: +420 2-243-117-42 

Mailpath: info-cz@intergraph.com



Denmark
INTERGRAPH DANMARK A/S (SUBSIDIARY) 

Roskildevej 39 

Frederiksberg, Denmark DK-2000 

Head Office: +45 36-19-20-00 

FAX: +45 36-19-20-01 

Help Desk: +45 36-19-20-20

Mailpath: info-denmark@intergraph.com



Ecuador
EBC INGENIERIA y COMPUTACION

Grafica Cia. Ltda.

Hungria 611 y Granja

Quito—Ecuador    SA

Tel. (593-2) 451-584

Fax. (593-2) 451-584

e-mail ebcquito@uio.satnet.net



Egypt
35,36 Mammar Soor Nadi El-Zamalek 

Cairo, Egypt 

Operator: +20 2-30-527-02 

Sales: +20 2-30-527-03 

FAX: +20 2-30-527-01



El Salvador
ASCI

9a. Calle Poniente No. 2-14

Santa Tecla, La Libertad

El Salvador

Tel. (503) 228-1133

Fax. (503) 228-0459

Email:    asci@es.com.sv



Finland
INTERGRAPH (FINLAND) OY (SUBSIDIARY) 

Kutojantie 11

02630 Espoo

Finland 

Operator: +358 9-80-4641 - 

FAX: +358 9-80-464333 - 

Mailpath: info-finland@intergraph.com



France
INTERGRAPH PUBLIC SAFETY (FRANCE) S.A. 

14, Parc Club Du Golf 

13856 Aix-En-Provence Cedex 3 - France 

Aix En Provence, France 

Operator: +33 4-4-21635-87 

FAX: +33 4-4-21635-09 

INTERGRAPH RHONE-ALPES 

Parc Saint Exupery - Bat. E 

6 Rue Maryse Bastie 

Bron, France 69500 

Operator: +33 472-370-116- 

FAX: +33 478-411-068- 

Mailpath: info-france@intergraph.com 

INTERGRAPH NANTES 

Centre D'Affaires Nantais 

5, Boulevard Vincent Gache - Bp 36204 

Nantes Cedex 2, France 44262 

Operator: +33 240-417-335- 

Sales: +33 240-417-340- 

FAX: +33 240-353-091- 

TELEX: +33 701-190- F - 

Mailpath: info-france@intergraph.com 

INTERGRAPH (FRANCE) S.A. BUREAU DE CHERBOURG 

Immeuble Cherbourg Helios 

120 Rue Roger Glinel B.P. 19 

Querqueville, France 50460 

Operator: +33 233-080-120- 

FAX: +33 233-080-082- 

Mailpath: info-france@intergraph.com 

INTERGRAPH (FRANCE) S.A. (SALES) 

95-101 Rue Des Solets - Silic 578 

Rungis Cedex, France 94653 

Operator: +33 1-456-030-00 

FAX: +33 1-456-048-85 

Mailpath: info-france@intergraph.com 



INTERGRAPH (FRANCE) S.A./Customer Services 

27 rue de Longjumeau - Silic 578 

Rungis Cedex, France    

Operator: 33-1-45120150 

FAX: 33-1-45120188 



Germany
INTERGRAPH (DEUTSCHLAND) GMBH 

Alt-Moabit 96b 

Berlin, Germany, Federal Republic Of D-10559 

Operator: +49 3-03999120- 

FAX: +49 3-03919427- 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH FEDERAL SYSTEMS 

Reuterstrasse 161 

Bonn, Germany, Federal Republic Of 53113 

Operator: +49 228-9140-9-56 

FAX: +49 228-9140-9-57 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH (SUBSIDIARY) 

Adalperostrasse 26 

D-85737 Ismaning, Germany, Federal Republic Of 

Operator: +49 89-9610-60- 

FAX: +49 89-9610-61-00 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH (SUBSIDIARY) 

Paul-Thomas-Strasse 58 

Duesseldorf, Germany, Federal Republic Of D-40599 

Operator: +49 211-974-60- 

FAX: +49 211-974-61-50 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH (SUBSIDIARY) 

Robert-Bosch-Strasse 5 

Dreieich-Sprendlingen 

Frankfurt, Germany, Federal Republic Of D-63303 

Operator: +49 610-337-70- 

FAX: +49 610-337-71-00 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH (SUBSIDIARY) 

Osterbekstrasse 90b 

Hamburg, Germany, Federal Republic Of D-22083 



Operator: +49 40-2785-00- 

FAX: +49 40-2733-60- 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH 

Kuesterstrasse 8 

3000 Hannover 81 

Hannover, Germany, Federal Republic Of D-30519 

Operator: +49 511-98-488-50 

FAX: +49 511-98-488-53 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH 

Lichtenbergerstrasse 8 

Ludwigshafen, Germany, Federal Republic Of D-67059 

Operator: +49 621-51787-8 

FAX: +49 621-51810-3 

Mailpath: info-germany@intergraph.com 

INTERGRAPH (DEUTSCHLAND) GMBH (SUBSIDIARY) 

Zettachring 4 

Stuttgart, Germany, Federal Republic Of D-70567 

Operator: 49-7-117253580 (Sales), 49-7-117253400 (Customer Service) 

FAX: 49-7-117288913 (Sales), 49-7-11724524 (Customer Service) 

Mailpath: info-germany@intergraph.com



Greece
Intergraph Hellas S.A.

237 Messogion Avenue 

154 51 - Neo Psychiko 

Athens, Greece 154 51 

Operator: +30 1-672909-1 

FAX: +30 1-672909-4 

Mailpath: info-greece@intergraph.com



Guatemala
DATA CODE S.A.

Avenida Reforma 1-50, Z. 9

Edificio el Reformador, Oficina 901

Guatemala, Guatemala

Central America

Telephone    (502) 334-5881

e-mail lgonzalez@datacode.com.gt



Hong Kong
INTERGRAPH HONG KONG LIMITED 

Units 401-4, 4/F., 72 Tat Chee Avenue 

Hong Kong Industrial Technology Centre 

Kowloon, Hong Kong 

Operator: +852 2593-160-0 

FAX: +852 2802-078-1 

E-mail: acchan@ingr.com

INTERGRAPH ASIA PACIFIC LIMITED INC

Room 210, Hong Kong Industrial Technology Centre,

72 Tat Chee Avenue,

Kowloon Tong,

Hong Kong.

Phone: +852 2-832 8390

FAX: +852 2-572978-7



Hungary
See Czech Republic 



India
ROLTA INDIA LIMITED (DISTRIBUTOR)

ROLTA BHAVAN, 22nd Street

MIDC-MAROL, ANDHERI-EAST

Bombay (INDBOM)                                            

Phone #: 91228368850    

FAX #: 91228365992

Telex: 9531179139

Answerback: RLTA IN

Mailpath: adtayal@rolta.com 



Indonesia
NV PD SOEDARPO CORPORATION (DISTRIBUTOR) 

Samudera Indonesia Building 

7th Floor, Ji Letjen S Parman Kav 35 

Jakarta, Indonesia 11480 

Operator: +62 21-548500-4 

FAX: +62 21-548499-4 

TELEX: +62 79-645867- 

GRAPIKA (DISTRIBUTOR) 

Harco Mangga Dua Plaza, Blok All/111 

Jalan Mangga Dua Raya 

Jakarta, Indonesia 10730 

Operator: +62 21-61-298-05 

FAX: +62 21-61-298-06 

PT INDOGRAF TEKNOTAMA 

Menara Mulia, 24th Floor, Suite 2407 

Ji. Jenderal Gatot Subroto Kavs 9-11 

Jakarta, Indonesia 12930 

Operator: +62 21-525748-8 

FAX: +62 21-520406-4



Ireland
INTERGRAPH IRELAND LIMITED (SUBSIDIARY) 

Stradbrook House 

Stradbrook Road, Blackrock, Co. 

Dublin, Ireland 

Operator: +353 1-28-013-66 

FAX: +353 1-28-011-16 

Mailpath: info-uk@intergraph.com



Israel
EASTRONICS LTD. (DISTRIBUTOR)

P.O. Box 39300

11 Rozanis St.

Tel Aviv (Israel)

Phone #: 97236458777    

FAX #: 97236458666

Mailpath: gilad_benozer@easx.co.il 



Italy
INTERGRAPH ROME 

Via Dino Frescobaldi 7 

Roma, Italy 00137 

Operator: +39 6-8689720-0 

Sales: +39 6-8689719-8 

FAX: +39 6-8689719-5 

Mailpath: info-italy@intergraph.com 

INTERGRAPH ITALIA L.L.C. (BRANCH) 

Strada 7 Palazzo R1 

Milanofiori 

Rozzano (Mi), Italy 20089 

Operator: +39-2-575451 

FAX: +39-2-57512470 

Mailpath: info-italy@intergraph.com

TRIESTE OFFICE

c/o Fincantieri

Palazzo della Marineria

34100 Trieste

    P: 39-40-3193537



Japan
INTERGRAPH JAPAN K.K. OSAKA BRANCH OFFICE 

12f Shin-Osaka 2nd Mori-Building 

3-5-36 Miyahara, Yodogawa-Ku 

Osaka, Japan 532-0003 

Operator: +81 6-39-477-11 

FAX: +81 6-39-437-33 

INTERGRAPH JAPAN K.K. 

Shibuya Tohoseimei Bldg. 26f 

2-15-1 Shibuya, Shibuya-Ku 

Tokyo, Japan 150-0002 

Operator: +81 3-546-773-60 

FAX: +81 3-546-770-61 

kkuroda@tokyo.tokyo.ingr.com

MUTOH INDUSTRIES, LTD. (DISTRIBUTOR) 

3-1-3, Ikejiri 3-Chome 

Setagaya-Ku 

Tokyo, Japan 

Operator: +81 3-548-611-11 

Sales: +81 3-548-671-55 

FAX: +81 3-548-671-69 

TELEX: +81 T-OKY-O 2-42-257



Jordan
S M S (DISTRIBUTOR) 

P.O. Box 1387 

Amman, Jordan 

Operator: +962 64-62490-7 

FAX: +962 64-62825-8 

Mailpath: info-middleeast@intergraph.com



Korea
INTERGRAPH KOREA, LTD. (BRANCH OFFICE - FIELD SERVICE) 

Dongsan Bldg.    #73-39, Yongho-Dong 

Kyungsangnam-Do 

Changwon, Korea 641-041 

Operator: +82 551-81-7738/9 

FAX: +82 551-81-7737 

INTERGRAPH KOREA, LTD. (MAIN OFFICE) 

Royal Bldg #1459-12, Seocho 3-Dong 

Seocho-Ku 

Seoul, Korea 137-073 

Operator: +82 2-3489-0300 

FAX: +82 2-3489-0411 

Mailpath: mjkim@korex.korea.ingr.com

INTERGRAPH KOREA, LTD (SUBSIDIARY) - BRANCH OFFICE-FIELD SERVICE 

Tool Business Center 6-322 

289-1, Daehwa-Dong, Daeduk-Ku 

Taijeon, Korea 306-020 

Operator: +82 42-670-6850      

Sales: +82 17-201-1531 

FAX: +82 42-670-6851



Kuwait
INTERGRAPH TECHNICAL SERVICES MIDDLE EAST LIMITED (BRANCH) 

C/O M.A. Kharafi 

P.O. Box 5090 

Salmiyah 22061, Kuwait 

Operator: +965 5623571- 

FAX: +965 5623496- 

Mailpath: info-middleeast@intergraph.com 



Latin American Countries (Not Elsewhere Specified)
INTERGRAPH CORPORATION

Attn: Latin American Regional Office

Mailstop:        HQ036

Huntsville, Alabama 35894-0001

TEL.:    (256) 730-2738

FAX: (256) 730-2620

Email: mmshephe@ingr.com



Lebanon
INTERGRAPH MIDDLE EAST LLC 

Dora Highway 

Cite Dora 3 Bldg., 10th Floor, P.O. Box 90-710 

Beirut, Lebanon 

Operator: +961 881-32-2 

FAX: +961 881-32-2



Malaysia
INTERGRAPH SYSTEMS (MALAYSIA) SDN BHD (SUBSIDIARY) 

1st Floor, North Wing Block

Syed Kechik Foundation Bldg.

Jalan Kepas, Bangsar

51900 Kuala Lumpur

Malaysia

Operator: +60 3-28-335-04 

FAX: +60 3-28-335-12 

ANTARAGRAFIK SYSTEMS SDN BHD

1st Floor, North Wing Block

Syed Kechik Foundation Bldg.

Jalan Kepas, Bangsar

51900 Kuala Lumpur

Malaysia

Operator: +60 3-28-335-04 

FAX: +60 3-28-335-12



Mexico
INTERGRAPH DE MEXICO, S.A. DE C.V.

Durango #263 Col. Roma—Piso 7

México, D.F. 06700

Tel. (525) 207-5262

Fax. (525) 207-3547

Email: gsmadrig@ingr.com

INTERGRAPH DE MEXICO, SA DE CV (SUBSIDIARY)-MONTERREY BRANCH 

Kalos-Centro Financiero 

Zaragoza 1300 Sur 254y255-Piso A2 

Monterrey, NL, Mexico 64000 

Operator: +52 8-34-528-70 

FAX: +52 8-34-529-90



Netherlands
INTERGRAPH BENELUX B.V. (SUBSIDIARY) 

Siriusdreef 2, 2132 Wt Hoofddorp 

P.O. Box 333, 2130 Ah Hoofddorp 

Hoofddorp, Netherlands, The 

Operator: +31 23-5666666- 

FAX: +31 23-5666665- 

Mailpath: info-nederland@intergraph.com 



New Zealand
INTERGRAPH CORP. (NZ) LIMITED (SUBSIDIARY) 

Level 5 

71 Symonds Street 

Auckland, New Zealand 

Operator: +64 9366-171-2 

FAX: +64 9366-171-5

INTERGRAPH CORP. (NZ) LIMITED (SUBSIDIARY) 

Level 1, Walsh Wrightson Tower 

94 Dixon Street 

Wellington, New Zealand 

Operator: +64 4-38-533-04 

FAX: +64 4-38-482-74

prlaw@nz.ingr.com



Norway
INTERGRAPH NORGE AS, OSLO 

Nesoyveien 4 

P.O. Box 184 

Billingstad, Norway 1361 

Operator: +47 66-98585-8 

FAX: +47 66-84585-4 

Mailpath: info-norway@intergraph.com 

INTERGRAPH NORGE AS, STAVANGER (SUBSIDIARY) 

Stokkamyrveien 20 

4300 Sandnes

Norway 

Operator: +47 51-7097--50 

FAX: +47 51-7097--97 

Mailpath: info-norway@intergraph.com



Oman
See United Arab Emirates 



Pakistan
INTERGRAPH MIDDLE EAST L.L.C. C/O OVERSEAS DEVELOPMENT CORPORATION 

House No. 20 

Street -28, F-6/1 

Islamabad, Pakistan 

Operator: +92 51-22170-0 

FAX: +92 51-21749-7



Panama
Continex International S.A.

World Trade Center,

Piso 14, Oficina 1403

Panama, Rep. de Panama

Attn: Hernan Caamano

Email: hcaamano@superior.co.cr



Peru
Soluciones Graficas S.A. (SOLGRAF)

Av. Reducto 1370 - Miraflores

Lima 18

Peru

Attn: Adolfo Cabrera Manzur

Email: malbornz@solgraf.com.pe



Poland
INTERGRAPH EUROPE (POLSKA) 

17 Stycznia 32 

Warszawa, Poland Poland 02-148 

Operator: +48 22-60-995-10 

Sales: +48 22-60-995-20 

FAX: +48 22-60-995-15 

Mailpath: info-poland@intergraph.com



Portugal
INTERGRAPH (PORTUGAL), S.A. 

Tagus Park 

Edificio Inovacao I, 223-224 

Oeiras, Portugal 2780 

Operator: +351 1-421241-4 

FAX: +351 1-421613-1 

Mailpath: info-portugal@intergraph.com



Puerto Rico
ENTEC Corporation

Paseo Covadonga # 104

Primer Piso

San Juan, Puerto Rico 00901

Commonwealth of Puerto Rico      00926

Tel. (787) 289-9090

Fax. (787) 289-9096

E-Mail tohabibe@habibe.com

E-MAIL amontoya@habibe.com



Romania
See Czech Republic 



Russia
INTERGRAPH SVERIGE AB 

Chayanova Street, 15 

Building 5, 3rd Floor 

Moscow, Russia 125267 

Operator: +7 095-97-341-84 

FAX: +7 095-97-341-86 

Mailpath: info-russia@intergraph.com



Saudi Arabia
INTERGRAPH SAUDI ARABIA LTD. TECHNICAL SUPPORT DIVISION 

7th Floor, Fluor Daniel Arabia Bldg. 

Dammam/Al-Khobar Highway 

Al Khobar, Saudi Arabia 31952 

Operator: +966 3-85-785-77 

FAX: +966 3-85-749-67 

Mailpath: info-middleeast@intergraph.com 

INTERGRAPH SAUDI ARABIA LTD. P.O. BOX 9843 

Tahlia Street, El-Khayyat Commercial Center 

3rd Entrance, 2nd Floor, Suite 213 

Jeddah, Saudi Arabia 21423 

Operator: +966 2-66-568-81 

FAX: +966 2-66-002-26 

Mailpath: info-middleeast@intergraph.com 

INTERGRAPH SAUDI ARABIA LTD. 

Al Mousa Center, 2nd Tower, 5th Floor 

Suites 251-255, Olaya Street, P.O. Box 54668 

Riyadh, Saudi Arabia 11524 

Operator: +966 1-46-223-35 

FAX: +966 1-46-476-87 

Mailpath: info-middleeast@intergraph.com



Singapore
INTERGRAPH SYSTEMS SOUTH-EAST ASIA (PTE) LTD. (SUBSIDIARY) 

85 Science Park Drive 

#02-01/04 The Cavendish 

Singapore, Singapore 118259 

Operator: +65 779-017-7 

FAX: +65 779-071-7 

TELEX: +65 786-201-05

Email: vchia@ingr.com



Slovak Republic
See Czech Republic 



South Africa
Intertech Systems Limited (distributor)

P.O Box 4307 Halfway House

Midrand

1685 Gauteng 

Republic of South Africa

Tel.: + 27 11 31 312 22

Fax: + 27 11 31 312 00



Spain
INTERGRAPH (ESPANA) S.A. (SUBSIDIARY - BRANCH OFFICE) 

C/Nicaragua 46 1o 1a 

Barcelona, Spain 08029 

Operator: +34 3-32-120-20 

FAX: +34 3-32-147-73 

Mailpath: info-spain@intergraph.com 

INTERGRAPH (ESPANA) S.A. (SUBSIDIARY) 

Calle Gobelas, 47-49 

La Florida 

Madrid, Spain 28023 

Operator: +34 1-37-280-17 

FAX: +34 1-37-280-21 

TELEX: +34 4-70-13 - 

Mailpath: info-spain@intergraph.com 

INTERGRAPH (ESPANA) S.A. (SUBSIDIARY - BRANCH OFFICE) 

Parque Industrial PISA

C/Exposicion, Parcela 6 

Local 12-13, Puerta 2 

41927 Mareina de Aljarafe

Sevilla, Spain    

Operator: +34 5-41-834-31 

Mailpath: info-spain@intergraph.com 

INTERGRAPH (ESPANA) S.A. (SUBSIDIARY - BRANCH OFFICE) 

C/ Las Mercedes, 8 10o. A 

48930 Las Arenas - Getxo 

Vizcaya, Spain 

Operator: +34 4-46-340-66 

FAX: +34 4-46-338-65



Sweden
INTERGRAPH (SVERIGE) A.B. 

Hammarbacken 12 

P.O. Box 420 

Sollentuna, Sweden S-191 24 

Operator: +46 8-92-540-0 

FAX: +46 8-96-186-8 

Mailpath: info-sweden@intergraph.com 

Gothenburg Office

August Barks Gata 30

421 32    Västra Frölunda                    

    P: 46-31-471810



Switzerland
INTERGRAPH (SWITZERLAND) AG (SUBSIDIARY) 

Thurgauerstrasse 40 

Zurich, Switzerland CH-8050 

Operator: +41 1-30-848-48 

FAX: +41 1-30-849-19 

Mailpath: info-ch@intergraph.com



Taiwan
INTERGRAPH CORPORATION TAIWAN (SUBSIDIARY) 

Attention: Kelly Wu

11-3 Fl.,    21st Century Building

207, Tun Hua N. Rd. 

Taipei, Taiwan 10592

Republic of China 

Operator: +886 2-27164458 

FAX: +886 2-27164383

Email: kwu@ingr.com 

SoftHome International Inc. (Distributor)

5F, No 20-8 Lane,

76 Lung Chang Road,

Taipei, Taiwan,

Republic of China

Operator: +886 2-25078298

FAX: +886 2-25078303

Email: pid@ms1.chwa.com.tw

http://www.softtech.com.tw



Thailand
LOXLEY INTERGRAPH (THAILAND) LIMITED (DISTRIBUTOR) 

Gypsum Metropolitan Tower, 9th Floor 

539/2 Sri Ayuthaya Road, Rajdhavee 

Bangkok, Thailand 10040 

Operator: +66 2-2-488-2746 

FAX: +66 2-2-488-278



Trinidad and Tobago
CCS A    Division of Nealco Information Systems, Ltd.

61-63 Edward Street

P.O. Box 544

Port of Spain—Trinidad, W.I.

Tel. (868) 625-1204

Fax. (868) 623-5426

Email: sjuteram@neal-and-massy.com



Turkey
INTERGRAPH COMPUTER SERVICES INDUSTRY AND TRADE A.S. 

Abidin Daver Sokak No. 3/6-7 

Cankaya 06680 

Ankara, Turkey 

Operator: +90 312-44-090-48 

Sales: +90 312-44-090-49 

FAX: +90 312-44-035-51 

Mailpath: info-middleeast@intergraph.com 

INTERGRAPH A.S. 

Perdemsac Plaza - Bayar Cad. 

Gulbahar Sok. No. 17/146, Kat 11, No. 111-112 

Istanbul, Turkey 

Operator: +90 216-44-567-55 

Sales: +90 216-44-567-56 

FAX: +90 216-44-567-54 

Mailpath: info-middleeast@intergraph.com



United Arab Emirates
INTERGRAPH MIDDLE EAST L.L.C. (SUBSIDIARY) 

P.O. Box 45805 

Abu Dhabi, United Arab Emirates 

Operator: +971 2-27380-0 

FAX: +971 2-27168-6 

Mailpath: info-middleeast@intergraph.com 

INTERGRAPH MIDDLE EAST L.L.C.

P. O. Box 24294

Arif & Bintoak Building

Zabeel Road

Dubai (UAEDUB)

Phone #: 9714367555      

FAX #: 9714367076

Mailpath: info-middleeast@intergraph.com



United Kingdom
INTERGRAPH (UK) LIMITED (SUBSIDIARY) 

Delta Business Park 

Great Western Way 

Swindon, Wiltshire United Kingdom SN5 7XP 

Operator: +44 1793-61999-9 

FAX: +44 1793-61850-8 

Mailpath: info-uk@intergraph.com 

See Ireland 



United States
Intergraph Corporation

Corporate Headquarters

Huntsville, AL 35894-0001

USA

Operator: 1-800-345-4856 (U.S.), 256-730-5499 (Outside U.S.)

http://www.intergraph.com

Registration address:

Intergraph Corporation

Software Product Registration

One Madison Industrial Park

Huntsville, AL 35824-9985

USA

Registration FAX: 1-256-730-6597

http://www.intergraph.com/register



Uruguay
Unigraph Ltda.

Edificio Torre el Gaucho

Constituyente 1467 Oficina 1709

Montevideo, — Uruguay

South America

Telephone/fax (59-82) 4030763

Cell phone 598 99 663585.

Email: unigraph@adinet.com.uy

Planirel

Juan Benito Blanco 3398

Montevideo 11300

Uruguay

South America

Telefax: 598-2-6224599

 598-2-6286911

E-mail: infospac@adinet.com.uy



Venezuela
Intergraph Servicios de Venezuela, C.A.

C.C.C. Tamanaco, Torre C. Piso 11,

Oficina C-1102/CHUAO

Caracas, Venezuela 

OR

Apartado Postal 64606

Zona Postal 1064-A

Caracas—Venezuela

Tel. (58) 2 959 2770

(58) 2 959 2484

Fax. (58) 2 959 2715

Email: ingr03@ccs.internet.ve

MARACAIBO OFFICE EDIFICIO LOS ROQUES 

Calle 72 Con Ave. 3y No. 72-31 

Local 3-2 

Maracaibo, Estado Zulia Venezuela 

Operator: +58 6-177646- 

PUERTO LA CRUZ OFFICE EDIFICIO PROHABITAT 

Oficina 1-D, Interseccion Calle 

Providencia Con - Simon Rodriguez 

Puerto La Cruz, Estado Anzoategui Venezuela 

Operator: +58 8-167358-6 

Sales: +58 8-167345-9 



Vietnam
INTERGRAPH VIETNAM INC. 

801-802 Hanoi Tung Shing Square 

2 Ngo Quyen Street 

Hanoi, Vietnam 

Operator: +84 4-82-626-50 

FAX: +84 4-82-626-60 



Yemen, Repubic of
See United Arab Emirates 



The Web browser cannot start
You cannot view this information if you do not have Web browser software. To load a Web browser, you can run 
Setup again and choose an option to load Internet Explorer from the CD-ROM that came with your software. 
Then, you can click the link in the Read Me Help document again to activate the Internet Explorer and view the 
HTML page.



The Web browser cannot start
You cannot view this information for one of the following reasons:

You do not have Web browser software. To load a Web browser, you can run Setup again and choose an 
option to load Internet Explorer from the CD-ROM that came with your software. Then, you can click the link in the 
Read Me Help document again to activate the Internet Explorer and view the HTML page.

You do not have an Internet connection. To get a connection, you can call an Internet service provider.
Your modem is not connected to the Internet. You should connect first and then click the link again to view 

this information. 



Cannot start e-mail
If you do not have e-mail software loaded or do not have a connection to the Internet, you cannot click this button
to send e-mail messages. To obtain a connection to the Internet, you should contact a local Internet provider.

If your e-mail software does not start, you can follow the instructions, To Create Your Own Request, in the E-mail 
Help topic.



SBL2.HLP cannot start
If you loaded on-line Help to your hard drive, open the Windows Explorer and double-click on this document: \
PROGRAM FILES\Smartsketch\PROGRAM\RESDLLS\009\SBL2.HLP. If you did not load Help to your hard 
drive, you can double-click the SBL2.HLP document from the software CD-ROM.



What’s New for SmartSketch LE V 3.0 
SmartSketch LE 3.0 is a technical drawing and diagramming product. It is the baseline for a line of add-ins and 
solutions for the technical drawing, CAD, and professional/business diagramming marketplace. SmartSketch LE 
is a limited edition of the full product

Tip    You might want to print this topic. Right-click in the topic window and click Print Topic.
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Content Overview

Improved User Interface

In Version 3.0, we’ve made several changes to the user interface (UI) based on feedback from our customers 
and to incorporate new features and changes to the product. Let’s take a look at the main interface:



Changes to the Main Toolbar include:
Added Hyperlink command 
Added Relationship toolbar (Relationships were moved from Change toolbar) 
Added Layers ribbon bar 
Removed Symbols button 
Renamed the Label toolbar to Dimension 
Added Zoom In command 
Moved Create Symbol command to the Draw toolbar (mentioned below) 
Replaced Browser button with the Symbol Explorer button 
Added new Symbol Explorer along with the Attribute Viewer 

All the new features are discussed in greater detail in later parts of this document 

Here are the changes made to the Draw Toolbar:



Changes to note on the Draw toolbar include: 
Added the Place Double Line command 
Removed the Line command; replaced entirely with the Line/Arc command - no longer supports button down

mode. 
Added the Connector command. 
Combined the Curve, Freesketch, and Freeform commands on one fly-out menu. 
Combined the Circle and Ellipse commands on one fly-out menu. 
Added Text command (moved from the Label toolbar). 
Combined the Fillet and Chamfer commands on one fly-out menu. 
Added the Fill command (moved from the Label toolbar). 
Added the Create Symbol command (moved from the Symbol ribbon bar).

Grid Display and Grid Snap

A grid can now be displayed to aid in precision drawing. The options for Grids are located under Tools>Options 
on the View tab as displayed below. The Grid Display and Grid Snap toggles are also available on the View 
Menu and on the right mouse shortcut when the Select Tool is active. Grid Snap can also be toggled using the 
F3 key.



Grid Display - turns the display of the grid on and off. Note that grid lines will not print out. 

Grid Snap - turns the grid snap on and off. Grid Snap places the cursor on grid intersections during placement 
and modification commands. Note that the SmartSketch options and Alignment Indicator override the Grid Snap. 
You can suppress SmartSketch and Alignments by holding down the Alt key. 

Static Grid Style – maintains a grid with a constant minimum spacing 

Grid Spacing - determines the distance between major grid lines 

Grid Index - determines the number of minor grid lines to be equally spaced between the major grid lines 

Dynamic Grid Style - allows the grid spacing to change based on the Zoom magnification. 

Grid Density – sets the dynamic grid spacing to a Fine, Medium, or Course setting 

Zoom In

A Zoom In command is now available on the Main toolbar. Zoom In enlarges the display of elements around a 
specified point in the active window. If you have an IntelliMouse or a three-button mouse, you can zoom in by 
rolling the wheel of the IntelliMouse.

Persistent Zoom Commands

The Zoom commands (Zoom Area, Zoom Out, and Zoom In) now stay active until another command, the right 
mouse button, or the Escape key is chosen.



Right Mouse in Drawing Space

The following shortcut menu has been added for right mouse clicks anywhere in the drawing space. 

Grid Display and Grid Snap - toggle on and off the display of grids and the grid snap lock. 

Properties brings up the properties of the file (same as File > Properties from the main menu) 

The other options are self-explanatory. 

Template Solutions

Version 3 introduces new templates that set up the appropriate units, scale, toolbars, and symbols to produce a 
specific type of drawing.

File New Dialog Box

The templates are presented in the File New dialog box. This dialog box now supports double click to create 
documents.

Task Specific UI 

When a specific template is chosen, several things happen to provide a task specific environment:

The appropriate tools are presented:
Schematic drawings (primarily created using symbols, connectors, and text at a 1:1 scale) The Schematic 

toolbar is shown with the Select Tool, Connector, Delete, Text, Fill, Grid Display On/Off, and Grid Snap On/Off. 
Precision drawings (primarily created using drawing tools) 
The Draw toolbar is shown with the Select Tool, Line, Connector, Arc, Curve, Circle, Rectangle, Text, Fillet, 



Trim, Extend, Fill, and Create Symbol.
Note: You can bring up the Draw toolbar if necessary using the View/Toolbars menu.

The file is set up with appropriate settings: Units (Imperial or Metric), Drawing Scale, Line Styles, Fill Styles, 
Borders, etc.

The Symbol Browser displays the appropriate symbol set for the task. Note: You can change the default 
location using the File/Properties Browser tab.

Symbol Explorer

Symbol Explorer provides a simple user interface to allow you to navigate to different directories and their 
content. This feature replaces the Symbol browser from V2. The Symbol Explorer is comprised of an Address 
Box, Tree View, Content View, and Favorite Buttons. If the path in the Address Box is set to an http address, then
a typical Internet Explorer View is displayed in place of the Tree View, Content View, and Favorite Buttons.

The Symbol Explorer can be docked and resized.

The Tree View pane uses the same navigation as the Windows Explorer to reveal or conceal directories from a 
user defined root level directory. The right mouse menu provides you a means of creating Favorite buttons as 
shortcuts to directories. 

The Favorite Buttons provide shortcuts to directories (displayed or non-displayed). Display of Favorites is 
controlled from the right mouse menu over the favorite buttons or the content view.

The Content View pane displays a list view of content, and can display one or more Favorite Buttons. This pane 
supports the filtering of file types in the list view from the right mouse menu. Symbols can be drag and dropped 
from this window. 

The Explorer View is only displayed when the browser path or address box is set to an http address. This view 
provides equivalent functionality for viewing html files as does Microsoft's Internet Explorer, and is used for 
legacy customers that may have legacy html file for content viewing. Internet Explorer is required for this feature 
and Internet Explorer 4.0 is supported. Internet Explorer is not required for standard symbol browsing.

Symbols

Symbol functionality has been improved to allow you greater flexibility on drag and drop, modifications, and 



symbol to symbol/symbol to geometry behavior. We have delivered new symbol sets for each industry to take 
advantage of these new features. 

Stamp mode on drop

Using the Right mouse button to drag in a symbol will cause a menu to appear prompting to Place, Stamp, or 
Cancel the symbol in dynamics. The Stamp mode provides an optional method for placing many instances of the
same symbol into your drawing. Holding down the <Ctrl> key while dragging a symbol from the Symbol Explorer 
will start the Stamp mode automatically.

Dynamic display on drop

A picture of each symbol is now displayed on the cursor as you drag it into your drawing from the Symbol 
Explorer or from Windows Explorer. This provides greater accuracy as you place the symbol into your drawing.

Connect Points

Connect points define the location and angle where connectors can automatically attach to symbols. The 
connect points on a symbol will display while you are placing a connector and you pass your cursor over a 
symbol or element. If a symbol has no connect points defined, the connector will locate and attach to key points 
on the symbol. Connectors will also attach to key points of generic elements such as lines, arcs, and circles. 

Drag Points

A drag point is the point to which the mouse cursor attaches to a symbol for dragging and dropping. A symbol 
can have multiple drag points which can be toggled using the up and down arrows on the keyboard as the 
symbol is dragged into the drawing. 



Drop Points

Drop points on a symbol define logical targets for labels and other symbols. A physical association is created 
when another symbol or a label is dragged and released on this point. 

Rotation

Another new feature available as a symbol is dragged is the ability to rotate it using the left/right arrow keys. If no
rotation angle is specified, the rotation angle will default to 90 degrees. A symbol defined with a rotation of 0 
degrees will not rotate using the arrow keys.

Alignment

Symbols and labels can be created with special alignment behavior. This behavior allows the symbol or label to 
automatically rotate and align itself parallel to another graphical object during drag and drop placement or when 
the symbol is repositioned after placement. 



Multiple Representation

Symbols can be created with multiple graphical representations. After the symbol is placed, a right mouse click 
will display a menu containing a list of names of each representation available for the symbol. This example 
illustrates the use of a symbol with multiple representations.





New Symbol Handles

Symbols can now have several different kinds of handles:



Scale handles are similar to those found in Version 2.0. Scale handles are the black boxes on the outside 
corners of the range box. Scale handles will allow you to scale a symbol uniformly in the X and Y directions. 

Mirror handles are represented by a green plus next to the symbol. 

Rotate handles are represented by a large green circle next to the symbol. 

Move handles are represented by small green dots at various points on the symbol.

Parameter handles are represented by yellow boxes in the middle of the range box lines. Parameter handles 
allow you to scale the symbol in a predefined manner defined when the symbol was first created. Parametric 
symbols contain geometry constrained together using relationships, with driving dimensions that are defined as 
adjustable parameters. 

Parametric Symbols

Parametric symbols are symbols containing graphics that are driven by one or more dimension. To create a 
parametric symbol, graphics must first be created using relationships to relate graphics together in a way that 
dimensions can be used to drive the resulting symbol size and shape. 

Attributes and the Attribute Viewer

Attributes can help you work more efficiently by allowing you to enter and edit values for a symbol, object, or 
element. Attributes can include such items as the manufacturer, price, and other data. Attributes include 
properties and parameters.

Parameters are driving attributes assigned to elements or objects and usually contain a numerical value 
representing a dimension. A parameter refers to variables in a symbol document that drive dimensional values. 

The Attribute Viewer displays the properties and parameters for a selected item. The viewer also allows you to 
edit the values of the properties or parameters. 



Note that you cannot edit the names of attributes in the Attribute Viewer (use right mouse>Properties); you can 
edit only their values. The viewer displays two columns, one for the name of the attribute and one for the value. 
Properties appear in plain text. Parameters appear in bold text. When editing attributes, you can only work on 
one element or object at a time. When more than one item in the document is selected, no attributes are 
displayed in the Attribute Viewer.

Labels

Labeling functionality now compliments all drawing workflows. Double-click any graphical object or symbol and a 
label will appear ready for text input. If a label already exists, the cursor will jump to the existing label ready for 
editing. Some labels will be symbols to be dragged and dropped into a drawing. Labels associate to another 
object or symbol such that when the object moves the label will follow. 
1 Double-click object.

2 Cursor appears.

3 Key-in text.

4 Label self-aligns to linear objects.



To move the label’s position, simply click on the label and a small green lock will appear. Click on the lock and it 
will temporarily unglue the label so you can move the label to a new position. This behavior is the same for both 
types of labels: Text Labels (non-attributed) and Smart Labels (with attribution).

1 Click to reposition.

 
2 Click on lock/unlock.

{
3 Move label with mouse pointer.



In addition to the behavior described above, a Smart Label is associated to an object or element's text attributes. 
A Smart Label displays the attributes of the element or object as text in the document. You can drag and drop 
Smart Labels from the Symbol Explorer into the current document. Smart Labels have a .SYM extension. As you 
change an element's or object's attributes in the Attribute Viewer or the Properties dialog box, the Smart Label's 
text displays those changes.

If an element or object has no attributes, and you drag a Smart Label to it, the element or object picks up the 
attributes of the Smart Label. For example, you might want to assign attributes to a valve, such as pressure and 
material type. If the Smart Label has the pressure and material type defined, and the valve does not, the Smart 
Label's pressure and material type are copied to the valve. 

If an element already has values assigned to its attributes, a Smart Label placed on the element displays the 
values that are already assigned to the element. Now if the label is edited the attribution for the symbol will also 
be updated. 

Drag in a Smart Label and touch a network symbol.

The Smart Label becomes associated to the network symbol and inherits the attribution.

New Commands

Connector



The Connector command is located on the Draw toolbar. This command connects two objects together with a 
connector. A connector will connect to native graphic objects such as lines and circles as well as complex objects
like symbols and groups. Symbols can be predefined with specific connect points which are recognized by the 
Connector command. Refer to the Symbol section for more information on how to define connect points. 

Style – Sets the line style for the connector. The Style dropdown lists several styles that automatically place start 
and end terminators. (Described in more detail in the next section) 

Line Color – Sets the line color for the connector. You can click the More option to define custom colors with the 
Colors dialog box. 

Line Type - Sets the connector line type and style. 

Line Width - Sets the line width for the connector. 

Line Start Terminator - Sets the terminator (arrow, slash, etc.) for starting the connector. 

Line End Terminator - Sets the terminator for ending the connector. 

Clearance – Specifies the amount of space that is maintained between the connector and the connected 
element. (Also known as range avoidance.) 

Diagonal Mode (Alt) – at placement time, switches the connector placement between drawing horizontal and 
vertical line segments or drawing diagonal line segments. At modification time, inserts a vertex in a line segment 
of the connector for diagonal placement. This option can also be activated using the Alt key. 

Insert Segment Mode (Shift) - Inserts line segments into the connector. This option is available only when you 
are modifying a connector. This option can also be activated using the Shift key. 

Line Terminators

As with Connectors, other linear geometry can contain start and end terminators. The following new styles have 
been added to the list of default line styles:

Hyperlink Command

The Hyperlink command adds hyperlinks to objects, symbols, text, connectors, and elements, such as lines, 

circles, ellipses, and groups. Hyperlinks can be made to a file or a web page on the Internet. 

When using the Hyperlink command, special attention should be made to the message bar at the bottom of the 
screen. When the cursor is over an element and that element is highlighted, the prompt will read Left click to add 
a link, Right click for menu. The following dialog will then display when an element is chosen with a left click.



Note that you can add up to five hyperlinks to an element. Hyperlinks cannot be added to dimensions, elements 
contained in nested symbols, or fills.

If a right click is done while an element is highlighted, the following shortcut menu will display.

When the cursor is not over an element, the following prompt appears at the bottom of the SmartSketch window:
Left click to highlight objects with links, Right click for menu. If a left click is chosen, all objects or elements with 
links will be highlighted. If a right click is chosen, the following shortcut menu will display:

On this menu, the Show Links option will also highlight all objects or elements containing links.

Offset Command

The Offset command is located on the Change toolbar. This command draws an offset copy of an element or a 
set of contiguous elements. 

Offset Chain - Selects a chain of continuous elements. If this option is not selected, Offset selects only an 
individual element. 

Step Distance - Sets the distance from the base element to the offset copy. 

Cumulative Offset - Sets the total distance of the current offset graphic element from the original graphic 
element.

Double Line Command

The Double Line command places parallel lines or a series of connected parallel lines. When drawing a series of 
lines, the second point of one line is the first point of the next line. 

The Double Line command cleans corners as lines are placed and puts endcaps on single lines. Doubleline also 
miters joints and trims as lines are drawn. This command is especially useful for drawing floor plans.



Left Primary Line - Indicates that you are drawing the double line from the left side. 

Right Primary Line - Indicates that you are drawing the double line from the right side. 

Center Primary Line - Indicates that you are drawing the double line from the center. 

Length - Sets the length of the double line. This box accepts only positive values. 

Angle - Sets the angle of the double line. This box accepts positive or negative values. A positive value is 
counterclockwise from the x axis, and a negative value is clockwise from the x axis. 

Thickness - Determines the thickness of the double line. For example, for a 6 inch wide wall, you would change 
the thickness to 6 inches.

Enhancements

Printer Settings

The Printer Settings dialog has been improved to provide a better preview capability. Note in the picture below 
that the Printer page size (displayed in black has been added).

Text Options



As noted in the Draw toolbar section, the Text command was moved from the Label toolbar to the Draw toolbar. 
The Text command has been enhanced to include a new ribbon bar as well as a new properties dialog for 
selected text. 

Text Ribbon Bar Changes:

Added the Text Color button 

Renamed Horizontal Alignment to Paragraph Alignment: Positions the paragraph to the left, center, or right of the
text area edges when you are in edit mode. 

Removed Vertical Justification 

Removed Left to Right and Right to left from the More toolbar

Info Tab

Width – Sets the width of the text box to either at least (at least the value you specify), automatic (the text drives 
the width), or exactly at the value you specify in the At: field. 

Height – Sets the height of the text box to either at least (at least the value you specify), automatic (the text 
drives the height), or exactly at the value you specify in the At: field. 

Unit Space – Sets the text box units to either paper units or to world units. Paper units represent units on an 
actual sheet of paper. Paper units are set in inches. Other units are also available. World units indicate real world



distances, but can be scaled down to fit a sheet of paper. 

Justification – Horizontal and Vertical (moved from Paragraph tab) 

Alignment – Specifies the placement of formatted text within the shape (text box). 

Horizontal and vertical components must be defined together. 

Margins – Sets the distance between the edge of the shape and the edge of the text area. Margins are in the 
same units as the text box. Top sets the distance between the top edge of the shape and the top edge of the text 
area. Bottom sets the distance between the bottom edge of the shape and the bottom edge of the text area.

Paragraph Tab

Units Space – Sets the paragraph to paper units or to world units. This control is modifiable only when you are 
creating new styles from the Format Styles dialog box. When you view this control from the Properties dialog 
box, it is read-only. It is modifiable from the Info tab since all paragraphs contained within a text box must be in 
the same units. 

Spacing Alignment – Specifies how each paragraph is aligned within the block of formatted text. Values for 
horizontal alignment include Left, Center, and Right. If Text Orientation is horizontal, you modify all the paragraph
alignment properties for all paragraphs within the text box. (These properties appear in the Text Alignment area 
of the Info tab.) If Text Orientation is vertical, you modify the shape alignment properties. (These properties 
appear in the Text Alignment area of the Info tab.

Miscellaneous Text Changes

Single click places text box without wrapping, unless a carriage return is used. 

Pressing End to go to end of line should now position cursor correctly when using arrow keys. 

Text can be displayed in both World and Paper space. 

Support for multiple styles (such as different color or font in same textbox). 

Text displays in lime green color if font is not present on system. 



New handle on textbox for origin point – denoted by an x. 

Textbox supports precision placement 

Text size can be specified by Point size – a value of 72 pt is equal to 1 inch.

Command Line Batch Printing

Command Line Batch Printing allows you to print SmartSketch documents from the command line, without 
having to bring up the SmartSketch interface. From a command line in an MS-Dos window, the syntax is as 
follows:

Imagine.exe<space>-p<space>-q<space><printer 
path><space>-c<space><integer for number of copies><space><document 
path><space><document path><space><document path, and so forth>
Here is an example: imagine.exe -p -q  -c 2 c:\temp\first file.igr c:\temp\
second_file.igr
Note that document paths are separated by spaces. If the filename contains a space, you must use double 
quotes. Also note that this command uses the print options that are set in SmartSketch except for the printer 
name and number of copies. 

You can use the command line locally or remotely when the Windows NT Server Resource Kit is installed. You 
can print from local and network printers and plotters. You can also print more than one document by using an 
asterisk * in the file name as a wildcard. The software is compatible with AIM—PWV (Aim and Information 
Management—Print Without View).

Add-In Manager

Add-ins are commands or functions that add special capabilities to SmartSketch. The Add-In Manager allows you
to select add-ins that are automatically available and ready to use when you start SmartSketch. With the Add-Ins 
command, you can install or remove:

Add-ins that come with SmartSketch. 
Add-ins that you have created.

To install an add-in, choose the Add-ins command from the Tools menu.

AutoSave

AutoSave automatically saves your document at specified time intervals. To activate this feature, select it from 
Tools>Add-Ins to add it to the Tools menu and then select Tools>AutoSave. 



Templates Overview

Version 3 includes templates with industry specific symbols. Wherever possible we have used Industry 
Standards (i.e., ANSI, ISO, ASHRAE, IEEE, etc.) or Intergraph Standards. We have also used some customer 
symbol sets that represent standard practice where a standard was not available.

Template Source of Symbols

General Diagramming
Atlas Map (Metric) IGR Symbol Set 
Atlas Map (Imperial) IGR Symbol Set 
Basic Diagram (Metric) IGR Symbol Set 
Basic Diagram (Imperial) IGR Symbol Set 
Directional Map (Metric) IGR Symbol Set 
Directional Map (Imperial) IGR Symbol Set 
Flowchart (Metric) IGR Symbol Set 
Flowchart (Imperial) IGR Symbol Set 
Network Diagram (Metric) Altima Technologies Inc 
Network Diagram (Imperial) Altima Technologies Inc 
Office Layout (Metric) IGR Symbol Set 
Office Layout (Imperial) IGR Symbol Set 
Organization Chart (Metric) IGR Symbol Set 
Organization Chart (Imperial) IGR Symbol Set 
Workflow Diagram (Metric) IGR Symbol Set 
Workflow Diagram (Imperial) IGR Symbol Set 

Drawing
Electrical (Imperial) IGR Symbol Set
Electrical (Metric)) IGR Symbol Set
Mechanical (ANSI) IGR Symbol Set
Mechanical (ISO) IGR Symbol Set
Technical Drawing (Metric) IGR Generated
Technical Drawing (Imperial) IGR Generated
Technical Illustrated (Metric) IGR Symbol Set
Technical Illustrated (Imperial) IGR Symbol Set

Sample Files

A set of drawing samples for version 3.0 is delivered in the SmartSketch\samples directory.




